
Darbas su skaičiuokle LibreOffice Calc 7-8 klasėms

1. Kas yra skaičiuoklė?
Susipažinsime  su  skaičiuokle  LibreOffice  Calc –  programa,  kuri  naudojama  įvairiems 

duomenims apdoroti: jiems palyginti, grupuoti, su jais atlikti įvairius aritmetinius veiksmus; braižyti 
grafikus bei diagramas;  rašyti įvairias formules. Skaičiuoklių būna įvairių, pvz.  Microsoft Excel,  
IBM Lotus Symphon, Google Drive. Tarpusavyje įvairios skaičiuoklės yra labai panašios, skiriasi tik 
nežymiais dalykais, pvz., meniu ir mygtukų išdėstymais.

2. Kur galima parsisiųsti?
Skaičiuoklė  LibreOffice  Calc yra  nemokama,  ją  galima  laisvai  parsisiųsti  iš  interneto 

(www.libreoffice.org/download).  Ji  tinka  daugumai  operacinių  sistemų (pvz.:  Windows,  MAC, 
Linux),  ją  galima parsisiųsti  įvairiomis  kalbomis.  Kadangi  Lietuvoje kompiuteriuose dominuoja 
lietuvių ir anglų kalbos, įvairūs veiksmai su skaičiuokle čia bus aptarti dvejomis kalbomis – lietuvių 
ir anglų. 

Jei  turite gana galingą kompiuterį,  galite išmėginti  ir kitą nemokamą skaičiuoklę –  IBM 
Lotus Symphony, tačiau, norint ją parsisiųsti, reikalinga registracija 
(http://www-03.ibm.com/software/lotus/symphony/home.nsf/home).  Ši  programa  veikia 
daugumoje operacinių sistemų (pvz.: Windows, MAC, Linux).

Skaičiuoklė  Microsoft  Excel yra  mokama,  todėl  parsisiųsti  jos  iš  interneto  negalima.  Ją 
reikia pirkti. Tiksliau, perkamas yra visas  Microsoft Office paketas, o  Microsoft Excel skaičiuoklė 
yra viena iš programų, įeinančių į tą paketą.  Microsoft Office programų paketas tinka tik dvejoms 
operacinėms sistemoms – Windows ir MAC.

3. Darbo knyga
Pradėkime nuo skaičiuoklės pagrindinių terminų. Skaičiuoklės failas, su kuriuo dirbame, yra 

vadinamas darbo knyga. Ji turi kelis puslapius (angl. sheets), kurie dar gali būti vadinami lakštais.

4. Lakštai
Puslapiai  (lakštai)  yra  reikalingi  tokiam  atvejui,  jei  kuriame  dokumentą,  turintį  daug 

duomenų. Duomenys pagal jų pobūdį paprastai yra grupuojami skirtinguose lakštuose (pavyzdžiui, 
jei  kuriame  savo  pažymių  knygelę,  galime  susikurti  tris  lakštus  su  pavadinimais  1trimestras, 
2trimestras, 3trimestras).

Kiekvieną  lakštą  galima  pervadinti  –  tereikia  spustelėti  ant  jo  pavadinimo  dešinį  pelės 
klavišą ir išlindusioje kortelėje pasirinkti  Pervadinti (angl.  Rename Sheet). Toje pačioje kortelėje 
matome įvairius veiksmus, kuriuos galime atlikti su lakštais. Vienas iš jų –  Šalinti (angl.  Delete  
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Sheet). 
Jeigu yra nepakankamas esamų lakštų kiekis, galime jų susikurti daugiau, spustelėdami ant 

mygtuko su žaliu pliusu (kaip pavaizduota 1 Pav.). Jeigu sukursime pakankamai daug lakštų, kai 
kurių  lakštų  pavadinimų  nebesimatys.  Tam,  kad  matytųsi  kuo  daugiau  lakštų,  reikia  su  pele 
patraukti už slinkties į dešinę pusę (1 Pav.).

Kartais kuriant skaičiuoklės dokumentą prireikia į du lakštus suvesti tuos pačius duomenis. 
Tokiu atveju galime pasižymėti du lakštus – rašant į vieną lakštą, automatiškai bus rašoma ir į kitą. 
Norint  pažymėti  du  ar  daugiau  lakštų,  reikia  nuspausti  klaviatūros  klavišą  CTRL ir,  jį  laikant,  
paspausti ant kito lakšto pavadinimo. Kurie lakštai yra pažymėti, matosi pagal pakitusią jų spalvą.

5. Priemonių juostos
Skaičiuoklė turi tris pagrindines priemonių juostas:

Kaip matome 2 pav., pagrindinės juostos yra:  standartinė, formatavimo ir  formulių. Dvi 
pirmosios  yra  labai  panašios  į  tekstų  rengyklės  LibreOffice  Writer (arba  Microsoft  Word 2003) 
priemonių  juostas,  todėl  daugelį  funkcijų  jūs  jau  žinote.  Formulių  juosta paprastai  dar  būna 
vadinama funkcijų juosta arba formulių/funkcijų eilute.

Kiekvienoje programoje galime susitvarkyti  priemonių juostas taip, kaip mums patogiau. 
Pavyzdžiui, nereikalingas priemonių juostas galima išjungti, kad jos nebūtų rodomos. Tai galima 
atlikti meniu juostoje nuspaudus ant Rodymas (angl.  View) → Mygtukų juostos (angl.  Toolbars) ir 
pasirodžiusiame sąraše paukšteliais pažymėti/nužymėti norimas juostas.

6. Mastelis
Kaip ir  daugelyje  kitų  programų, skaičiuoklėje galime pasikeisti  mastelį.  Meniu juostoje 

reikia pasirinkti Rodymas (angl. View) → Mastelis (angl. Zoom), o tuomet pasirinkti norimą mastelį.
Mastelis gali būti keičiamas ir kitu būdu – dešiniajame apatiniame programos lango kampe 

yra slinktis su + ir – bei parašytais procentais. Slenkant su pele slinktį, keičiasi lakšto mastelis.

7. Langeliai ir jų koordinatės
Skaičiuoklės  darbo  knyga  turi  labai  daug  langelių.  Jais  galime  keliauti  su  klaviatūros 

rodyklėmis arba su pele. Kiekvienas langelis turi savo  koordinatę, kuri yra sudaryta iš stulpelio 
raidės bei eilutės skaičiaus (pvz., A1). Langelis, kuris yra pažymėtas, yra vadinamas  aktyviuoju. 
Aktyviojo langelio koordinatę matome formulių juostos kairiojoje pusėje (žr. 2 pav.). 

Su pele galime pažymėti ne tik vieną langelį, bet ir kelis langelius (langelių bloką):
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Atkreipkite  dėmesį,  kad,  pažymėjus  langelių  bloką,  formulių  juostoje  matome  jau  nebe 
vieną  koordinatę,  o  dvi  (3  pav.).  Paprastai  yra  rodomos  pirmojo  (viršutiniojo  kairiojo)  bei 
paskutiniojo (apatiniojo dešiniojo) langelių koordinatės. 

Pažymėjus langelių bloką, vienas langelis yra apibrėžtas juodai. Tai – aktyvusis langelis. 
Jeigu pradėtume rašyti tekstą arba skaičius, jie rašytųsi į aktyvųjį langelį.

8. Stulpeliai ir eilutės.
Kaip jau buvo minėta, darbo knyga yra sudaryta iš stulpelių ir eilučių. Norint pažymėti vieną 

stulpelį, reikia nuspausti ant jo raidės:

Lygiai taip pat, jei norime pažymėti vieną eilutę, reikia spausti ant eilutės skaičiaus.
Norint  pažymėti  du ar  daugiau stulpelių/eilučių,  reikia  atlikti  tokius  veiksmus:  pažymėti 

vieną  stulpelį/eilutę,  laikyti  kairįjį  pelės  klavišą  ir  vesti  pelės  žymeklį  tolyn  (į  kairę/dešinę, 
viršų/apačią).

Norint  pakeisti  stulpelio/eilutės  dydį  (plotį/aukštį),  reikia  nuvesti  pelės  žymeklį  tarp 
stulpelio dviejų raidžių (eilutės dviejų skaičių), ir, kai pelės žymeklis pavirs į dvi rodykles (5 pav.), 
tempti į kurį nors šoną nuspaudus ir laikant kairįjį pelės klavišą.
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Norint  pakeisti  kelių  stulpelių/eilučių  dydį,  visų  pirma  reikia  pažymėti  keletą 
stulpelių/eilučių,  po  to  meniu  juostoje  nuspausti  ant  Formatas (angl.  Format)  →  Stulpelis → 
Plotis/Eilutė → Aukštis (angl. Column → Width/Row → Height) ir įvesti norimą centimetrų skaičių.

Navigacija po skaičiuoklės lakštą.
Skaičiuoklės  darbo  knygos  kiekvienas  lakštas  turi  labai  daug  eilučių  bei  stulpelių.  Jei 

slinktume slenkamąja juosta žemyn/dešinėn, pamatytume, kad sunku pasiekti lakšto pabaigą. Norint 
labai greitai atsidurti paskutinėje lakšto eilutėje, reikia nuspausti klaviatūros klavišą CTRL, ir jį 
laikant  nuspausti  rodyklę  žemyn.  Norint  pasiekti  paskutinį  stulpelį,  reikia  nuspausti  CTRL ir 
rodyklę į  dešinę. Norint grįžti  atgal į pirmąjį  langelį (A1), reikia nuspausti  klavišų kombinaciją 
CTRL+HOME.

Kita klavišų kombinacija – CTRL+END – nukelia mus į dešiniausiąjį apatinįjį  užpildytą 
langelį.  Pavyzdžiui,  jei  tolimiausias  užpildytas  langelis  buvo R204,  tai  nuspaudę  CTRL+END, 
nukeliausime į jį.

Stulpelių ir eilučių įterpimas bei šalinimas.
Norint įterpti ar pašalinti stulpelį/eilutę, visų pirma reikia pažymėti stulpelį/eilutę, tuomet 

nuvesti pelės žymeklį prie pažymėtojo stulpelio/eilutės raidės/skaičiaus ir nuspausti dešinįjį pelės 
klavišą.  Atsiradusiame  meniu  reikia  pasirinkti  norimą  veiksmą:  Įterpti/Šalinti  Stulpelius/Eilutes  
(angl. Insert/Delete Columns/Rows).

9. Fonas ir rėmeliai (kraštinės).
Suteikime  skaičiuoklei  šiek  tiek  spalvų.  Norint  pakeisti  langelių  foną  bei  rėmelius,  tai 

galima  atlikti  keliais  būdais.  Pavyzdžiui,  pažymėję  langelių  bloką,  nuspauskite  dešinįjį  pelės 
klavišą.  Atsiradusioje  kortelėje  pasirinkite  Langelių  formatas (angl.  Format  Cells).  Naujai 
atsiradusiame lange nuspauskite ant kortelės Fonas (angl. Background) ir, išsirinkę norimą spalvą, 
nuspauskite patvirtinimo klavišą (ENTER) arba mygtuką „Gerai“ (OK).

Išsikvieskite tą patį langą. Pasirinkite šalia kortelės  Fonas  esančią kortelę  Kraštinės (angl. 
Borders). 

Kaip  matome  6  pav.,  čia  galima  pasirinkti  nemažai  parametrų.  Norint  pakeisti  langelio 
kraštines, visų pirma reikia parinkti linijos stilių (angl. Style), jos storį (angl. Width), norimą spalvą 
(angl.  Color). Parinkus linijos parametrus, kairiojoje lango dalyje reikia nurodyti, kurioje langelio 
pusėje norime uždėti kraštinę:
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Kraštinių parinkimas atliekamas pele. 7 pav. yra parodyti keturi langeliai. Su pele spaudžiant 
ant tų  langelių kraštinių, rėmeliai arba atsiranda, arba išnyksta – priklausomai nuo to, kiek kartų ant 
tos pačios vietos nuspausime su pele.

Parinkus  norimas  kraštines,  spaudžiame  patvirtinimo  klavišą  (ENTER)  arba  mygtuką 
„Gerai“ (OK).

Norint pašalinti rėmelius ar spalvas, reikia pažymėti norimą langelį/langelių bloką, nuspausti 
dešinįjį pelės klavišą ir pasirinkti Šalinti formatavimą (angl. Clear Direct Formatting). Tačiau tokiu 
būdu bus panaikinti visi šių langelių nustatymai – lygiuotės, duomenų formatai ir t. t. Kitas būdas 
pašalinti  rėmelius  – pažymėti  norimą langelį/langelių bloką ir  klaviatūroje  nuspausti  Backspace 
klavišą.  Iššokusiame  lange  telieka  paukšteliais  pažymėti,  ką  norime  ištrinti  –  tekstą,  skaičius, 
formules, formatus ar kt.

10.Duomenų įvedimas.
Į  skaičiuoklės  langelius  galime  įvesti  įvairius  duomenis  –  tekstą,  skaičius,  datą,  laiką. 

Tereikia  pažymėti  norimą  langelį  ir  pradėti  rašyti.  Užbaigus  rašyti  į  langelį  tai,  ką  norime, 
spaudžiame rodyklę žemyn, jei norime atsidurti žemiau esančiame langelyje; rodyklę į dešinę, jei 
norime atsidurti dešinėje esančiame langelyje ir t. t. Jei, įrašę duomenis į langelį, nuspausime Enter, 
atsidursime žemiau esančiame langelyje. Redaguoti jau įrašytus duomenis langelyje galima įvairiai: 

• pažymėti norimą langelį ir tiesiog pradėti rašyti (šitaip bus keičiamas visas langelio turinys, 
o ne norima raidė ar skaitmuo);

• dukart  su  pele  spustelėti  ant  langelio,  padėti  teksto  žymeklį  norimoje  vietoje  ir  pradėti 
taisyti;

• pažymėti langelį, tuomet klaviatūroje nuspausti F2;
• pažymėti langelį ir taisyti norimą tekstą formulių eilutėje (8 pav.)

Pamėginkime  į  vieną  langelį  įrašyti  ilgą  sakinį.  Pastebėkime  (9  pav.),  kad  tekstas, 
„nekreipdamas dėmesio“ į langelio ribas, išsiplečia ir uždengia dešiniau esančius kitus langelius.

Jei įrašysime dešinėje esančiame langelyje kitą sakinį, pamatysime, kad pirmojo sakinio tam 
tikra dalis nebesimato – matosi tik tiek, kiek telpa į vieną langelį (10 pav.):
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Kad pirmajame langelyje yra įrašyti ne du žodžiai („Šešios žąsys“), o kažkas daugiau, mums 
parodo langelyje atsiradusi raudona rodyklėlė. Kad pamatytume viską, kas yra užrašyta pirmajame 
langelyje, pažymėkime jį ir pažvelkime į formulių eilutę:

Nors langelyje matome ne visus įrašytus duomenis (šiuo atveju – tekstą), formulės eilutėje 
visada matysime pilną langelio turinį ir jį galėsime redaguoti, jei reikia.

Tačiau  jei  visuose  langeliuose  nematysime,  kas  yra  parašyta,  bus  labai  nepatogu  dirbti. 
Taigi, kaip sutalpinti į vieną langelį tai, ką norime, kad viską matytume ir be formulių eilutės? Yra 
du būdai, kuriais pasinaudoti galime priklausomai nuo situacijos:

1. Praplatinkime stulpelį tiek, kad jame tilptų visas sakinys:

2. Nekeiskime stulpelio pločio – atlikime kitokį veiksmą. Pažymėkime langelį, kuriame yra 
netelpantis  sakinys,  nuspauskime  dešinįjį  pelės  klavišą,  pasirinkime  Langelių  formatas 
(angl.  Format  Cells).  Atsiradusiame  lange  pasirinkime  lango  kortelę  Lygiuotė (angl. 
Alignment) ir paukšteliu pažymėkime sakinį  Automatinis teksto laužymas (angl.  Wrap text  
automatically). Tekstas langelyje atrodys štai taip:

Šiuo atveju 13 pav. vienas sakinys yra sutalpintas į langelį, o kitas – ne.
Apibendrinimas. Nors pirmas būdas ir lengvesnis, tačiau jis netinka tokiais atvejais, kai 

langeliuose yra prirašyta daug teksto. Jeigu visuose vieno stulpelio langeliuose bus įrašyti įvairaus 
ilgio sakiniai, gali būti, kad teks tiek praplatinti vieną stulpelį, kad skaičiuoklėje bematysime tik 
kelis stulpelius, ir bus labai nepatogu toliau dirbti.
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Kai į langelį netilpo sakinys (tekstas), jame buvo parodyta raudona rodyklėlė. Tačiau jei į  
langelį netelpa skaičius, tuomet vietoje skaičiaus matysime groteles:

Tam, kad pamatyti,  koks skaičius yra įrašytas į langelį,  galima jį pažymėti ir pažvelgti į 
formulės eilutę. Žinoma, galime praplatinti ir stulpelį.

11. Lygiuotės.
Jei prisimenate iš ankstesnių klasių, tekstų rengyklėje tekstas yra lygiuojamas į kairę, dešinę 

ar per centrą naudojant lygiuotes. Priemonių juostoje yra keturios lygiuotės:

Kadangi skaičiuoklėje duomenis rašome ne į eilutes, o į langelius, čia galime nustatyti dvi 
skirtingas  lygiuotes  –  horizontaliąją  ir  vertikaliąją.  15  Pav.  matome  keturias  horizontaliąsias 
lygiuotes.  Kur  rasti  vertikaliąsias  lygiuotes?  Nuspauskite  meniu  juostoje  ant  Formatas  (angl.  
Format)  →  Lygiuotė  (angl.  Alignment) ir  pamatysite  visas  septynias  lygiuotes  –  keturias 
horizontaliąsias ir tris vertikaliąsias. Vertikaliosios lygiuotės yra:  Viršutinė, Vertikalioji centrinė ir  
Apatinė (angl. Top, Center, Bottom). Lygiuotę nustatome tik tiems langeliams, kurie yra pažymėti. 
Galime nustatyti lygiuotes kiekvienam langeliui atskirai, pvz.:

Pamėginkite garsiai pasakyti  16 Pav. esančio kiekvieno langelio nustatytas abi lygiuotes. 
(Pvz.: pirmas langelis – dešininė ir viršutinė; antras langelis – centrinė ir viršutinė ir t. t.).

12. Langelių suliejimas ir skaidymas.
Kartais prireikia iš kelių langelių padaryti vieną langelį (kitaip tariant – sulieti langelius), o 

kartais – išskaidyti jau sulietuosius langelius. Kaip tai padaryti?
Visų pirma, pažymėkime tiek langelių, kiek norime sulieti:
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Tuomet meniu juostoje pasirinkime Formatas → Sulieti langelius → Sulieti langelius. (angl. 
Format → Merge Cells → Merge Cells). Gausime tokį rezultatą:

Norint  vėl  išskaidyti  sulietus  langelius,  reikia  pažymėti  sulietąjį  langelį  ir  pasirinkti 
Formatas → Sulieti langelius → Skaidyti langelius (angl. Format → Merge Cells → Split Cells).

Štai pavyzdys, kaip galima pritaikyti langelių suliejimą:

19  Pav.  pavaizduotos  lentelės  pirmoje  eilutėje  buvo  sulieti  trys  langeliai  ir  gautame 
padidintame langelyje įrašyta „7a klasė“.

13. Vertikalusis teksto rašymas.
Tekstą langeliuose galima rašyti  ne vien horizontaliai,  bet  ir  vertikaliai  ar  pakreipus bet 

kokiu kitu kampu. Kaip tai atlikti:
• Parinkite ir pažymėkite langelį, kuriame įrašytas tekstas;
• Nuspauskite  dešinįjį  pelės  klavišą,  pasirinkite  Langelių  Formatas  (angl.  Format  

Cells);
• Atsiradusiame  lange  pasirinkite  lango  kortelę  Lygiuotė (angl.  Alignment).  Čia 

turėtumėte matyti nupieštas raides ABCD apskritime. Laikant pelytę, tas raides galima pasukti bet 
kiek  laipsnių  į  norimą  pusę  –  pagal  laikrodžio  rodyklę  arba  prieš.  Nustačius  norimą  laipsnį, 
nuspauskime Gerai (OK).

14. Duomenų formatai.
Visus  turimus  duomenis  galime  atitinkamai  sutvarkyti,  t.  y.  parinkti  norimą  formatą  – 

valiutą, procentus, datą, laiką ir kt., taip pat nustatyti, kiek skaičiuoklė rodys skaičių po kableliu. 
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Pažymėkite langelius, kuriuose yra įrašyti skaičiai, nuspauskite dešinį klavišą, parinkite  Langelių  
Formatas (angl.  Format  Cells).  Atsiradusiame  lange  parinkite  Skaičiai (Angl.  Number). 
Atsiradusiame sąraše galime parinkti  norimą kategoriją.  Pvz.,  parinkite  kategoriją  Valiuta (angl. 
Currency). Pastebėkite, kad čia galime išsirinkti valiutos formatą – dolerius, litus, latus, eurus ir kt. 
piniginius vienetus. Užrašas „Dešimtainės skiltys“ (angl. Decimal places) nurodo, kiek skaičiuoklė 
rodys skaičių po kablelio. Parinkus visus nustatymus, spaudžiame Gerai (OK). Atkreipkite dėmesį, 
kad visi jūsų turimi skaičiai pasikeitė pagal tai, kokius nustatymus parinkote. Pvz., jei langelyje 
buvo įrašytas  skaičius 8,7412, o prie  dešimtainių skilčių parinkote skaičių 2,  jūsų langelyje  šis 
skaičius matysis kaip 8,74.

15. Formulės.
Pagaliau  išsiaiškinsime,  kaip  su  skaičiuokle  galima  skaičiuoti.  Pradėkime  nuo  pavyzdžio. 
Surašykime į kelis skaičiuoklės langelius štai tokius skaičius, kaip pavaizduota 20 Pav.:

Su  šiais  skaičiais  mėginsime  atlikti  tam  tikrus  veiksmus.  Tarkime,  kad  norime  sudėti 
langeliuose A1 bei B1 turimus skaičius (t. y.  10+4). Išsirinkime bet kurį tuščią langelį,  kuriame 
atliksime  veiksmą  (Pvz.  C1).  Visus  skaičiavimus  turime  pradėti  nuo  ženklo  =,  taigi  į  langelį 
įrašykime: 

=A1+B1
Nuspaudę klavišą ENTER, langelyje C1 turėtume gauti atsakymą 14.  
Formulę galime rašyti ir tiesiai į formulės eilutę, jeigu jums taip patogiau:

Pažymėkite langelį C1, kuriame apskaičiavome sumą. Langelyje matome atsakymą 14, o ką 
matome formulės eilutėje?

Formulės eilutėje visuomet matysime veiksmą, kurį atlikome – t. y. formulę (arba funkciją, 
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bet apie funkcijas – šiek tiek vėliau).
Lygiai  taip  pat  galime  langelių  reikšmes  atimti,  padauginti  bei  padalinti.  Daugyba  yra 

žymima ženklu *, o dalyba ženklu /.
Pavyzdžiui,  norint  padauginti  langelio  A2  reikšmę  iš  langelio  B2  reikšmės,  į  atsakymo 

langelį rašome:
=A2*B2
Prisiminkite, kad atsakymo langelis gali būti bet kuris tuščias langelis, kurį pasirinksime. 

Tebūnie šįkart  atsakymo langelis  C2. Vadinasi,  C2 langelyje dabar matysime atsakymą 55, o tą 
langelį pažymėjus, formulės eilutėje matysime atliktą veiksmą:

Padalinkime  langelį  A3 iš  langelio  B3,  formulę  rašykime  į  langelį  C3.  Ar  sugalvojote,  ką  į  jį 
įrašysite? 
Štai atsakymas:

Atlikti  įvairius  matematinius  veiksmus  galime  su  bet  kuriais  langeliais,  nebūtinai  esančiais 
skirtinguose stulpeliuose. Galime sudėti, atimti, dauginti ir dalinti bet kuriuos norimus langelius. 
Pavyzdžiui:
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Panaudoti skaičiavimuose galime kiek tik norime langelių ir galime įrašyti ir kombinuoti 
kokius tik norime veiksmus – taip, kaip ir matematikoje. Atkreipkite dėmesį, kad atsakymai gali 
gautis ir neigiami, ir nesveikieji (su kableliu), kaip pavaizduota langelyje C6.

PASTABA: Atliekant  įvairius  skaičiavimus,  nėra  būtina  koordinačių  vardų  rašyti 
didžiosiomis raidėmis.  Jeigu norime sudėti  langelių A1 ir A2 reikšmes, galime į  norimą langelį 
įrašyti tiek =A1+A2, tiek =a1+a2. Tai esmės nekeičia.

Veiksmai su skaičiais, neegzistuojančiais skaičiuoklės langeliuose
Atlikti  įvairius  veiksmus  galime  ir  su  įvairiais  skaičiais,  kurių  net  nėra  skaičiuoklės 

langeliuose. Pavyzdžiui:

Čia buvo įrašytas atsitiktinai sugalvotas skaičius 130, kurio nebuvo nė viename skaičiuoklės 
langelyje.  Atsakymas gautas 144, nes 14+130=144. Galima atlikti įvairius norimus veiksmus su 
skaičiuoklėje esančiais bei nesančiais skaičiais, pvz.:

=A1*2
=B3+50
=A1+A2-158
=C1/50

Kažin, ar galima skaičiuoklėje rašyti vien tik savo sugalvotus skaičius nenaudojant langelių 
koordinačių ir atlikti su jais veiksmus? Pavyzdžiui:

=5+15
=10*18
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=3000-295
=6000/2-123

Taip, tikrai galima. Tačiau kodėl, norint sudėti langeliuose A1 ir B1 esančius skaičius 10 ir 
4, įrašėme formulę =A1+B1, o ne =10+4? Juk atsakymas būtų lygiai toks pat: 14. Esmė yra tame, 
kad skaičiuoklės langeliuose esančius skaičius reikalui esant galima pakeisti. Pavyzdžiui, langelio 
A1  reikšmę  vietoj  10  galime  pakeisti  į  20.  Tuomet  langelyje,  kuriame  buvo  įrašyta  =A1+B1 
atsakymas  pasikeis  ir  bus  24  (nes  20+4=24).  Tačiau  langelyje,  kuriame  bus  įrašyta  =10+4, 
atsakymas nepasikeis ir liks 14. Ar supratote, kodėl atliekant skaičiavimus reikia įrašyti langelių 
koordinates, o ne rašyti tiesiogines jų reikšmes? Jei nesupratote, pamėginkite atlikti keletą bandymų 
savo skaičiuoklėje su įvairiais skaičiais arba tiesiog perskaitykite paaiškinimą iš naujo.

Veiksmai su tuščiais langeliais
Kaip manote, kas nutiks, jeigu sudėsime du langelius: B1 ir B4? Langelyje B1 yra įrašytas 

skaičius 4,  o langelis  B4 yra tuščias.  Jeigu manote,  kad atsakymas bus 4,  esate visiškai  teisus. 
Tuščias langelis yra lygus nuliui, o 4+0=4. 

Pagalvokite, kokį atsakymą gausime, įrašę štai šias formules (pagal 28 Pav. duomenis):
=B1-B4
=B1*B4
=B1/B4
=B4/B5

Klaidos
1.  Kas  nutiks,  jei  pamėginsime  atlikti  aritmetinį  veiksmą  su  langeliais,  kuriuose  yra 

parašytas tekstas arba pavienės raidės? Pavyzdžiui:

Čia, matyt, buvo norima sudėti visus langelius nuo B3 iki B5, tačiau formulėje buvo įvestas 
vienas netinkamas langelis – A3. Langelyje A3 yra įrašytas ne skaičius, o žodis. Kadangi žodžių 
negalime nei atimti, nei sudėti, nei dar kaip kitaip apskaičiuoti, skaičiuoklė parašė žodį #VALUE! – 
tai reiškia klaidą. Konkrečiau, jei langelyje matome užrašytą žodį VALUE (išvertus lietuviškai tai 
reiškia „reikšmė“), vadinasi, kažkurio langelio reikšmė yra netinkama skaičiavimams. Šiuo atveju, 
tai yra langelio A3 reikšmė.

2. Dar viena iš dažnai pasitaikančių klaidų yra tokia: kai į langelį, kuriame rašome formulę, 
yra įrašoma JO PATIES koordinatė:
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Čia skaičiavimas buvo atliekamas langelyje B6, ir formulėje panaudotas tas pats langelis B6. 
Šitaip daryti NEGALIMA. Norimą skaičiavimą turime atlikti tuščiame langelyje ir nenaudoti jo 
koordinatės skaičiavimuose.

3. Jeigu mėginsime dalinti iš nulio, gausime štai tokį užrašą:

DIV/0  reiškia,  kad  dalyba  iš  nulio  negalima  (DIV yra  nuo žodžio  divide,  kuris  reiškia 
padalinti). Šią taisyklę jau turėjote žinoti iš matematikos.

16.Funkcijos

Norint  apskaičiuoti  paprastus  veiksmus,  kuriuos  ką  tik  aptarėme,  galime  naudotis 
formulėmis (noriu patikslinti, kad  formule yra vadinami bet kokie parašyti veiksmai su daugyba, 
dalyba, atimtimi, sudėtimi ir t.  t.). Tačiau jos nėra naudingos, norint atlikti veiksmus su labai daug 
langelių, pavyzdžiui, su dešimčia, šimtu, tūkstančiu ir daugiau. Štai pavyzdyje yra parodyta, kaip 
galima būtų apskaičiuoti 11-kos langelių sumą tokiu būdu, kurį ką tik išmokote:
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Skaičiuoklė, žinoma, šią sumą apskaičiuos teisingai. Tačiau šitaip skaičiuoti yra nepatogu. O 
kas,  jeigu  reikėtų  sudėti  tūkstantį  skaičių?  Du  tūkstančius?  Kiekvieno  langelio  koordinačių  gi 
nerašysime – tai užims per daug laiko. Šitokioms situacijoms yra sukurtos funkcijos. Funkcijos 
leidžia atlikti įvairius veiksmus su daug skaičių. Funkcijų skaičiuoklėje yra labai labai daug, tačiau 
mes aptarsime tik kelias.

1) Sudėties funkcija.
Pirmoji  funkcija  yra  skirta  sudėti  norimus  skaičius.  Jos  vardas  yra  SUM (sum yra  nuo 

žodžio suma). Iš pradžių norimame langelyje turime įrašyti lygybės ženklą, po to – funkcijos vardą, 
o po to skliausteliuose įrašyti langelių, kuriuos norime sudėti, koordinates. Kaip tai atrodo:

=SUM(A1:A11)
O štai ir pavyzdys su tais pačiais skaičiais, kurie ką tik buvo sudėti su paprasta formule:

Ką reiškia A1:A11? Tai yra langelių, kuriuos sudėjome, koordinatės. Dvitaškis nurodo, kad 
imsime reikšmes nuo langelio A1 iki langelio A11 imtinai. 

Jeigu  norėtume  sudėti  langelius,  esančius  dviejuose  stulpeliuose,  reikėtų  skaičiuoti  štai 
šitaip:

Skliausteliuose yra parašyta  A1:B11. Tai reiškia, kad bus paimti visi langeliai nuo A1 iki 
B11. Ar pamenate, kokia koordinatė buvo parašyta, kai pažymejote kelis langelius? Buvo parašyta 
kairiojo viršutiniojo bei dešiniojo apatiniojo pažymėtųjų langelių koordinatės, atskirtos dvitaškiu. 
Taip pat yra ir skaičiavimuose – visuomet turime parašyti langelių bloko viršutinįjį kairįjį langelį 
bei apatinįjį  dešinįjį.  Kad geriau suprastumėte,  kaip reikia įrašyti  langelių koordinates funkcijos 
skliausteliuose, štai dar keli pavyzdžiai:
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Visuose šiuose pavyzdžiuose pažymėtieji skaičiai buvo  sudėti todėl, kad funkcijos, kurią 
naudojome, vardas buvo SUM, o SUM   yra   sumos   funkcija  .

PASTABA:  Funkcijos  vardą  nebūtinai  turime  rašyti  didžiosiomis  raidėmis.  Užrašas 
=SUM(A1:B2) ir užrašas =sum(a1:b2) veikia visiškai vienodai.

Būna atvejų, kai sudėti reikia ne visus langelius, kai kuriuos reikia praleisti.  Pavyzdžiui, 
reikia sudėti šimtą langelių, išskyrus du, esančius kur nors viduryje. Arba, tarkime, norime sudėti 
kelis atskirus langelius, pažymėtus ne iš eilės. Kaip tai padaryti? Tokiam atvejui yra naudojamas 
kabliataškis vietoje dvitaškio. Pavyzdžiui:
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40 pav. buvo sudėti trys atskiri langeliai. Kabliataškis reiškia, kad langeliai bus paimti ne 
nuo kažkurio iki kažkurio, kaip buvo su dvitaškiu, o tai,  kad jie bus paimami atskirai.  Štai  dar  
vienas pavyzdys:

41 pav. buvo sudėti langeliai nuo A1 iki A3 (nes tarp jų parašytas dvitaškis) bei atskiras 
langelis B4, kuris buvo atskirtas kabliataškiu.

Pamėginkite sugalvoti, kaip užrašyti sumos funkciją, kuri sudėtų štai šiuos langelius (pagal 
41 pav.):

• A1, A2, C1, C2, C3.
• B1, B3, C1, C3.
• A1, A2, A3, A4, B1, B2, B3, B4, C4.

PASTABA: Jeigu mėgintumėme sudėti tuščius langelius su funkcija SUM, gautume 0.

2) Vidurkio funkcija.
Kita funkcija,  kurią aptarsime, yra skirta apskaičiuoti  vidurkiui.  Kur dažniausiai  naudoja 

vidurkį mokiniai ir mokytojai? Žinoma, skaičiuodami pažymių vidurkį, t. y. koks pažymys išeina 
trimestre ar semestre. Vidurkis dar yra naudojamas įvairiuose kituose skaičiavimuose, pavyzdžiui, 
koks yra vidutinis tam tikros žmonių grupės amžius ar atlyginimas, kiek vidutiniškai vaikų turi 
Lietuvoje gyvenančios šeimos ir t.  t.  Pavyzdžių galima sugalvoti  daug ir  labai įvairių.  Vidurkio 
funkcijos vardas yra AVERAGE (išvertus iš anglų kalbos šis žodis reiškia vidutiniškai, vidurkis). Ji 
yra užrašoma lygiai taip pat kaip ir funkcija SUM:

=AVERAGE(A1:B10).
Visos kitos funkcijos bus užrašomos lygiai taip pat: visų pirma lygybės ženklas, po to – 

funkcijos vardas, po to – skliausteliuose išvardintos langelių koordinatės.

3) Mažiausios reikšmės funkcija.
Funkcija, skirta surasti mažiausiai reikšmei (mažiausiam skaičiui), yra MIN. Jos užrašymo 

pavyzdys:
=MIN(C1:C3)
Pavyzdys su skaičiais:
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Čia buvo paimti visi duotieji skaičiai (kadangi yra parašyta A1:B4). Akivaizdu, kad iš visų 
paimtų skaičių, mažiausias yra neigiamas skaičius – minus 10. Taip apskaičiavo ir funkcija MIN.

Pamėginkite atsakyti į klausimus apie tą patį paveikslėlį (pav. 42):
• Ką apskaičiuos funkcija, jeigu ją užrašysime štai taip: =MIN(A1;B2;B4)
• Ką apskaičiuos funkcija, jeigu ją užrašysime štai taip: =MIN(A3:B4)
• Ką apskaičiuos funkcija, jeigu ją užrašysime štai taip: =MIN(B2:B4)

4) Didžiausios reikšmės funkcija.
Funkcija, skirta surasti didžiausiai reikšmei (didžiausiam skaičiui), yra MAX. Jos užrašymo 

pavyzdys:
=MAX(B3:B15)
Pavyzdys su skaičiais:

Jeigu turime štai tokius didelius skaičius, tai sudėtingiau pasakyti, kuris skaičius didžiausias. 
Ypač,  jeigu tų skaičių yra daug, tarkime, tūkstantis. Štai  tam ir pasitarnauja funkcija MAX – ji 
didžiausią skaičių randa akimirksniu. Tereikia tik mokėti taisyklingai užrašyti funkciją.

Tušti langeliai. Funkcijos AVERAGE, MIN ir MAX į tuščius langelius reaguoja kitaip nei 
funkcija SUM ar paprastos formulės (kurios įsivaizduodavo, kad tuščias langelis yra tas pats, kas ir 
nulis). AVERAGE, MIN ir MAX tuščius langelius tiesiog praleidžia ir į juos nekreipia dėmesio. 
Kitaip tariant, tuščias langelis šių funkcijų atveju nėra lygus nuliui. Jei į langelį būtų įrašytas nulis, 
tai  šios funkcijos šį  langelį  traktuotų kaip ir  visus kitus langelius,  kuriuose yra įrašyti  skaičiai.  
Kodėl  taip  yra?  Kaip  tai  geriau įsidėmėti?  Įsivaizduokite,  kad turite  pažymius 8,  9,  10,  10.  Jų 
vidurkis yra 9,25:
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Jeigu jie yra surašyti langeliuose iš eilės, bus viskas tvarkoje. Tačiau jeigu jie bus surašyti 
štai taip:

Jų vidurkis, žinoma, turi išlikti 9,25, nes pažymiai yra tokie pat; net jei tarp jų yra tuščių 
langelių.  Atkreipkite  dėmesį,  kad  funkcijos  skliausteliuose  yra  parašyta  A1:A7,  vadinasi,  buvo 
paimti ir tušti langeliai, tačiau vidurkis nepakito. Žinoma, buvo galima šią funkciją užrašyti štai 
taip: =AVERAGE(A1;A3;A6;A7), tačiau taip nėra patogu. Patys žinote iš patirties, kad į kiekvieną 
dienyno langelį pažymys nėra rašomas. Pažymius gaunate ne kasdien. O jei praleidote pamoką, tai 
vietoje tuščio langelio bus n raidė. Su vidurkio funkcija nebūtina „žaisti“, rašinėjant kabliataškius ir 
imant atskirus langelius. Su ja drąsiai galima pažymėti visą langelių bloką su turimais pažymiais, 
net jei ten ir bus tuščių langelių. Būtų nelogiška, jeigu visi tušti langeliai būtų traktuojami kaip 
nulis. Tuomet jūsų pažymių vidurkis gautųsi ne kažin koks...

Lygiai  tas  pats  su  MIN  ir  MAX  funkcijomis.  Jeigu  skaičiai  bus  bet  kaip  išbarstyti 
skaičiuoklės langeliuose, o mažiausias įrašytas skaičius bus 1, paėmus visus skaičiuoklės langelius 
– ir tuščius, ir netuščius, funkcija MIN rašys, kad mažiausias skaičius yra 1, o ne 0. 

5) Kiekio funkcija
Funkcija,  kuria  apskaičiuoja,  kiek  skaičių yra  įrašyta  į  langelius,  yra  COUNT.  Štai 

pavyzdys:
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46 pav.  langeliuose  yra  įrašyti  aštuoni  skaičiai  (langelio C7 nepriskačiuojame,  nes  jame 
buvo  atliktas  skaičiavimas).  Su  funkcija  COUNT  apskaičiavome,  kiek  skaičių  yra  surašyta 
langeliuose nuo A1 iki B6. Atsakymas gautas teisingas – aštuoni. Kadangi tuščiuose langeliuose 
nieko nebuvo įrašyta, funkcija COUNT jų ir nepriskaičiavo.

Dar vienas pavyzdys:

Čia atsakymas vis tiek yra 8, nors langeliuose prirašėme žodžių bei skaičiams uždėjome tam 
tikrus formatus – procentų bei valiutos. Skaičių kaip ir buvo, taip ir tebėra aštuoni. Žodžių, taip kaip 
ir  tuščių  langelių,  funkcija  COUNT  neskaičiuoja,  nes,  kaip  buvo  minėta,  COUNT  yra  skirta 
apskaičiuoti,  kiek SKAIČIŲ yra  įrašyta  į  langelius.  Šią  funkciją  taip pat  būtų galima pritaikyti 
skaičiuojant  jūsų  pažymius.  Pavyzdžiui,  kiek  pažymių  turite  iš  matematikos,  fizikos  ar  kito 
mokomojo dalyko. Arba – kiek pažymių turite iš viso.

6) Pi skaičiaus funkcija.
Matematikoje, fizikoje ar chemijoje susiduriate su skaičiumi  pi (π), kuris yra lygus 3,14. 

Skaičiuoklėje jį taip pat galima naudoti. Jis yra užrašomas štai taip:
=PI()
Ši funkcija, skirtingai nei kitos, nieko neturi skliausteliuose. Juose nereikia nieko įrašyti, 

tiesiog palikti tuščius. Pi skaičiaus panaudojimo pavyzdys:

Iš matematikos žinote, kad apskritimo ilgio apskaičiavimui reikia naudoti formulę: 2π r , 
kur  r – apskritimo spindulys. Čia spindulys  r buvo įrašytas į langelį A2, todėl skaičiavimuose ir 
sudauginome dvejetą, skaičių pi ir spindulį (A2): 2*PI()*A2.

Tikriausiai pamenate, kaip reikėtų padaryti, kad matytųsi mažiau skaičių po kablelio?
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Priminimas:  reikia  pažymėti  langelį  su  skaičiumi,  nuspausti  ant  jo  dešinį  pelės  klavišą, 
pasirinkti Langelių formatas (angl. Format Cells). Tuomet parinkti puslapį Skaičius (angl. Number) 
ir nustatyti norimą skaičių po kablelio prie dešimtainės skilties (angl. Decimal places).

7) Šaknies funkcija.
Norint ištraukti kvadratinę šaknį iš skaičiaus, reikia naudoti funkciją SQRT (tai du angliški 

sutrumpinti žodžiai – Sq  uare   r  oo  t     – kvadratinė šaknis). Ji yra užrašoma taip:
=SQRT(A1)
Ką įrašysime skliausteliuose, iš to ir trauksime šaknį. Dar keli pavyzdžiai:

Skaičiuoklėje: Matematikoje:

=SQRT(16) √16

=SQRT(A1+5) √ A1+5

=SQRT(A5-B1) √ A5−B1

=SQRT(25)+5 √25+5

17.Laipsnio kėlimas
Norint  su  skaičiuokle  skaičių  pakelti  laipsniu  (pavyzdžiui  42),  tai  galime  atlikti  dviem 

būdais. Pirmasis – naudojant formulę, antrasis – naudojant funkciją.

Pirmasis būdas:

Čia pakėlėme langelio B2 reikšmę laipsniu, esančiu langelyje C2 (t. y. skaičių 4 pakėlėme 
kvadratu). Ženklas ^ reiškia laipsnio kėlimą. Visų pirma parašome skaičių, kurį norėsime pakelti 
laipsnių,  o po to – laipsnį.  Štai  dar keletas pavyzdžių,  kaip laipsnio kėlimas yra užrašomas šia 
formule:
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Matematikoje: Skaičiuoklėje:

36 =3^6

47 =4^7

5003 =500^3

100C1 =100^C1

Pastaba: Ženklas ^ yra vadinamas stogeliu.

Antrasis būdas:

Yra speciali funkcija, skirta laipsnio kėlimui. Jos vardas yra POWER. Ji užrašoma štai taip:
=POWER(B2;C2)

Pirmasis skaičius skliausteliuose yra laipsnio pagrindas (skaičius, kurį kelsime laipsniu), o 
antrasis – laipsnio rodiklis.

Dar keletas pavyzdžių:

Matematikoje: Skaičiuoklėje:

36 =POWER(3;6)

B9A7 =POWER(B9;A7)

500C1 =POWER(500;C1)
18.Veiksmų prioritetai
Iš  matematikos  jau  žinote,  kad,  naudojant  keletą  veiksmų  vienoje  formulėje,  vienus 

veiksmus atliekame pirmiau, kitus – paskiau. Pavyzdžiui, skaičiuojant veiksmą 5+7*8 visų pirma 7 
sudauginame su 8, o prie gautosios sandaugos pridedame 5. Vadinasi, pirmiau atliekame daugybą, o 
po to – sudėtį. Lygiai taip pat skaičiuoja ir skaičiuoklė. Štai eilės tvarka, ką skaičiuojame pirmiau, o 
ką – paskiau (kitaip tariant, prioritetai):

Veiksmų prioritetai

1. Laipsnis ir šaknis ^ (POWER) ir SQRT

2. Veiksmai skliausteliuose ( )

3. Daugyba ir dalyba * /

4. Sudėtis ir atimtis + -
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Pavyzdžiui,  turime  štai  tokį  reiškinį: Šiame  reiškinyje  visų  pirma 
ištrauksime šaknį iš 25, po to prie gautojo atsakymo pridėsime penkis, o gautąją sumą padauginsime 
iš 10.

Pamėginkime  išnagrinėti,  kaip  tokie  ir  panašūs  reiškiniai  yra  užrašomi  ir  skaičiuojami 
skaičiuoklėje:

Matematikoje: Skaičiuoklėje:

54
+

1
2

=POWER(5;4)+1/2 arba =5^4+1/2
Trupmena yra parašoma su dalybos ženklu, nes viena antroji reiškia 
vienetą padalinti iš dvejeto.

1+6
13

=(1+6)/13
Jokiu būdu ne =1+6/13, nes tokiu atveju veiksmų seka pakistų: 6 
būtų padalinta iš 13, o po to prie dalmens būtų pridedamas 1

1+
6

13
=1+6/13

√5+4⋅30 =SQRT(5+4)*30
Kodėl 5+4 yra apskliausta? Prisiminkite, kas yra rašoma funkcijos 
SQRT  skliaustuose  –  iš  ko  traukiame  šaknį,  tą  ir  įrašome  į 
skliaustelius

√5+4⋅30 =SQRT(5)+4*30

(√25+5)÷10 =(SQRT(25)+5)/10

(
1
2
)

2

−(
1
4
)

3 =POWER(1/2;2)–POWER(1/4;3) arba =(1/2)^2–(1/4)^3
Jei laipsnį keliame su stogeliu, trupmeną reikia apskliausti, nes jei 
neapskliausime, laipsniu pakeltas bus tik trupmenos vardiklis

1

22
+

1

43
=1/POWER(2;2)+1/POWER(4;3) arba =1/2^2+1/4^3

2A1+3A2−13 =2*A1+3*A2–13
Čia  A1  ir  A2  –  skaičiuoklės  langelių  koordinatės.  Panašiai  kaip 
matematikoje kintamieji x arba y

(B3+14)
4 =POWER(B3+14;4) arba =(B3+14)^4

Funkcijoje  POWER  reiškinio  B3+14  apskliausti  nereikia,  nes 
kabliataškis  jau  nurodo  skaičiuoklei,  kad  laipsniu  kelsime  būtent 
reiškinį B3+14, o ne atskirai B3 ar 14

Pamėginkite savarankiškai skaičiuokle užrašyti šiuos reiškinius (kad žinotumėte, kad tikrai 
teisingai  darote,  apskaičiuokite  tuos  reiškinius  su  skaičiavimo  mašinėle  bei  su  skaičiuokle,  ir 
palyginkite atsakymus. Atsakymai turi gautis vienodi):
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19.Kopijavimas, greitasis kopijavimas, įklijavimas ir specialusis įklijavimas 
Skaičiuoklėje teksto, skaičių bei kitų elementų kopijavimas yra šiek tiek kitoks nei kitose 

programose  bei  failų  ir  aplankų  tvarkyme.  Visų  pirma  išsiaiškinkime,  kaip  yra  nukopijuojami 
langeliai su paprastu tekstu, spalvomis ir kraštinėmis. Tarkime, kad turime štai tokią lentelę:

Pažymime kelis lentelės langelius ir, paspaudę dešinįjį pelės klavišą, spaudžiame Kopijuoti 
(arba CTRL+C):

Pastebėkite, kad langeliai, kurie bus kopijuojami, yra apvesti mirksinčia punktyrine linija:

(PASTABA: Punktyrinė  linija  neišnyks  tol,  kol  nepasirinksime  kito  langelio  ir  vėl 
nenuspausime  Kopijuoti)  Pasirenkame norimą skaičiuoklės  langelį  ir  įklijuojame (dešinys  pelės 
klavišas ir Įdėti (Įklijuoti), (angl. Paste), arba CTRL+V). 
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58  pav.  buvo  pasirinktas  langelis  G3  ir  buvo  nuspausta  Įdėti.  Matome,  kaip  ir  kas 
nusikopijavo: langelių formatai išliko tokie pat (t. y. langelių kraštinės, spalvos, teksto spalvos bei 
stilius), tekstas ir skaičiai persikopijavo, valiuta liko tokia pat. Tačiau tekstas nebetelpa į langelius. 
Kodėl?  Langelių,  į  kuriuos  kažką  kopijuosime,  dydis  nesikeičia.  Jeigu  norėtume,  kad  viskas 
atrodytų lygiai taip pat, turėtume pakeisti atitinkamų langelių plotį.

Jei kopijuojamuose langeliuose būtų buvęs įjungtas teksto laužymas, tai nukopijavus tuos 
pačius langelius į langelį G3, būtų gautas štai toks vaizdas:

Kaip matote, nukopijavus gavome sulaužytą tekstą, nes taip buvo nustatyta kopijuojamuose 
langeliuose.
Yra  dar  ir  kitoks  kopijavimo  būdas,  vadinamasis  specialusis  įklijavimas (LibreOffice  Calc 
skaičiuoklėje specialusis įklijavimas yra išverstas „Įdėti kitaip“ arba „Kitoks įdėjimas“, o angliškai 
–  Paste Special). Kopijuojant šiuo būdu galima pasirinkti, ką norėsime kopijuoti. Galbūt norime 
kopijuoti tik tekstą. O gal – tik kraštines ir spalvas. Kur rasti specialųjį įklijavimą? Jis bus arba 
nuspaudus dešinį pelės klavišą šalia meniu Iškirpti, Kopijuoti, Įdėti, arba meniu juostoje Taisa → 
Įdėti  kitaip (angl.  Edit  → Paste Special...).  Langas,  kuriame galime pasirinkti,  ką kopijuosime, 
atrodo štai taip:
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Prie žodžio  Atranka (angl.  Selection) galime pažymėti, ką kopijuosime: nužymėkime žodį 
„viską“ ir pažymėkime tik tai, ko mums reikia. Išmėginkite kelis kopijavimo būdus ir žiūrėkite, kuo 
jie skiriasi.

Apie duomenų šalinimą iš langelių jau kalbėjome, tačiau yra dar šis tas, ką reikia paminėti. 
Jeigu  norime  ištrinti  vien  tik  tekstą  ar  skaičius,  klaviatūroje  užtenka  nuspausti  klavišą  Delete  
pažymėjus norimus langelius.  Tačiau jei  norime pašalinti  daugiau nei tekstą  ar skaičius,  galime 
nuspausti klavišą Backspace. Tuomet išlenda labai panašus langas į specialiojo įklijavimo langą (60 
pav.), kuriame yra klausiama, ką gi mes norime ištrinti – tekstą, formules, formatus ir t. t.

Skaičiuoklėje egzistuoja ne tik paprastas (Kopijuoti-Įklijuoti/Copy-Paste) kopijavimas, bet ir 
greitasis  kopijavimas.  Įrašytą  žodį,  skaičių,  formulę ar funkciją galima vienu pelės paspaudimu 
nukopijuoti į kiek tik norime langelių.

Žemiau esančiame paveikslėlyje yra įrašyti du žodžiai į du langelius. Juos abu pažymėjus, 
pelės  žymeklį  reikia  nuvesti  prie  langelio  apatinio  dešiniojo  kampo,  kuriame  matosi  juodas 
kvadratėlis:

Kai  pelės  žymeklis  pavirs  į  kryžiuką,  reikia  nuspausti  kairįjį  pelės  klavišą  ir,  laikant  jį, 
tempti žemyn. Gausis štai toks vaizdas:
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Pavyzdyje  buvo  nukopijuotas  abiejų  langelių  turinys,  nes  jie  abu  buvo  pažymėti.  Jei 
norėtume nukopijuoti trijų langelių duomenis, žymėtume tris langelius ir temptume žemyn ir t. t.  
Šitaip kopijuoti tempiant pelytę galima ne tik žemyn, bet ir aukštyn, kairėn arba dešinėn.

Įrašykite į vieną langelį skaičių 1 ir tempkite žemyn, paėmę už to langelio apatinio dešiniojo 
kampelio. Ką gavote?

Įrašykite  į  vieną  langelį  skaičių 1,  o  į  sekantį,  žemiau esantį  langelį  taip  pat  skaičių 1. 
Tuomet juos abu pažymėkite ir tempkite žemyn. Ką gavote?

Pamėginkite dar vieną greitojo kopijavimo pavyzdį: įrašykite į vieną langelį skaičių 3, o į 
žemiau esantį langelį – skaičių 5. Tuomet juos abu pažymėkite ir tempkite žemyn. Ką gavote?

20.Formulių ir funkcijų kopijavimas 
Skaičiuoklėje  kopijuodami  formules  ir  funkcijas,  susidursime  su  keliomis  skaičiuoklės 

savybėmis. Įrašykite į langelius A1, A2, B1 ir B2 tokius skaičius, kaip 62 pav.:

Langelyje C5, kaip pavaizduota 62 pav., sudėkime langelius A1 ir B1. Žinoma, gausime 
rezultatą 11. Gautą rezultatą nukopijuokite į tris langelius:  į dešinę (D5), žemyn (C6) ir įstrižai  
(D6). Pastebėsite, kad buvo gauti skirtingi rezultatai. Kodėl taip nutiko? Pažymėkite langelį D5 ir 
pažiūrėkite į formulės eilutę. Kokią formulę matote? Jeigu teisingai nukopijavote, turėjo gautis štai 
tokia formulė: =B1+C1. Kadangi B1 yra 6, o C1 – nulis, natūralu, kad buvo gautas atsakymas 6 
(nes  6+0=6).  Pažymėkite  langelį  C6  ir  pažiūrėkite,  ar  gavosi  formulė  =A2+B2.  Įstrižai 
nukopijuotame langelyje turėjote gauti =B2+C2. Tai yra visiškai normalu. Skaičiuoklė kopijuoja 
formules pagal šias tris taisykles:

1. Kopijuojant formulę į kairę/dešinę, keičiasi joje įrašytų langelių stulpelių raidės.
2. Kopijuojant formulę aukštyn/žemyn, keičiasi joje įrašytų langelių eilučių skaičiai.
3. Kopijuojant formulę įstrižai, keičiasi ir stulpelio raidės, ir eilučių skaičiai.

Kaip  tai  įsidėmėti?  Labai  paprasta.  Pamėginkite  pažymėti  pirmąjį  stulpelį  (A).  Po  to 
pažymėkite  stulpelį,  esantį  dešiniau  (stulpelį  B).  Po  to  pažymėkite  stulpelį  C.  „Keliaujant“ 
stulpeliais į dešinę pusę, keičiasi stulpelių raidės abėcėlės tvarka. Lygiai taip pat, kaip ir kopijuojant 
formulę į dešinę pusę. O jeigu keliausime į kairę pusę, stulpelio koordinatės keisis atvirkščia tvarka: 
raidė C pavirs į B, raidė B pavirs į A.

Keliaujant  eilutėmis  žemyn,  natūralu,  kad  kinta  eilutės  skaičius.  Keliaujant  langeliais 
įstrižai, keičiasi ir stulpelis, ir raidė.

Pamėginkite nukopijuoti (pagal Pav. 62) langelį C5 į langelį C7. Pažiūrėkite, kokią formulę 
gavote. Pamėginkite langelį C5 nukopijuoti į langelį C8. Nežiūrėdami į formulės eilutę sugalvokite, 
kokia gavosi formulė. Po to pasitikrinkite.

Lygiai taip pat elkitės su bet kuriuo kitu langeliu – D7, D8, D9, E5, E6 ir t. t. Kopijuokite 
formulę tol, kol suprasite, kaip keičiasi koordinatės kopijuojant.

Jeigu  pabandėte  kopijuoti  langelį  C5 į  langelį  B5,  turėjote  gauti  klaidą  (#REF!).  Kodėl 
gavosi klaida? Todėl, kad C5 langelyje buvo įrašyta formulė =A1+B1, o kopijuojant formulę į kairę, 
koordinatės turėtų keistis pagal abėcėlę atvirkščia tvarka: langelis B1 pavirstų į A1, tačiau langelis 
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A1 nebegali virsti į nieką, nes A stulpelis yra pirmasis. Stulpelio A kairėje nieko nėra. Lygiai tą  
pačią klaidą gautume, jei mėgintume kopijuoti į viršų (į langelį C4) todėl, kad virš pirmosios eilutės 
nieko nėra, o formulėje įrašytos koordinatės yra A1 ir B1. Koordinatės A0 ir B0 neegzistuoja.

Jeigu norėtume nukopijuoti ne formulę, o jos gautąjį rezultatą (koks buvo langelyje C5 – t. 
y. skaičius 11), turėtume naudoti specialųjį įklijavimą (Taisa → Įdėti kitaip; angl. Edit → Paste  
special)  ir  atsiradusiame  lange  pažymėti,  kad  norime  kopijuoti  tik  skaičius  (visa  kita  reikia 
nužymėti).  Tuomet,  į  kurį  langelį  bekopijuotume,  su  specialiuoju  įklijavimu  gautume  vienodą 
rezultatą: 11. 

21.Duomenų rikiavimas
Įvairiais atvejais turimus duomenis reikia surikiuoti. Jeigu tai žodžiai, juos rikiuojame pagal 

abėcėlę nuo A iki Ž arba nuo Ž iki A. Jeigu skaičiai – didėjimo arba mažėjimo tvarka.
Tarkime, turime surašytus žmonių vardus bet kokia tvarka:

Norint  juos  surikiuoti  pagal  abėcėlę,  reikia  juos  visus  tiesiog  pažymėti  ir  paspausti 
priemonių juostoje vieną iš mygtukų:

Gerai būtų, jei rikiuoti būtų taip lengva. Tačiau čia prasideda įvairūs keblumai. Surikiavus 
duomenis tokiu būdu, gausime tokį rezultatą:

Visi vardai tapo surikiuoti pagal abėcėlę nuo A iki Ž, tačiau pirmasis vardas kaip buvo, taip 
ir liko nepajudėjęs iš vietos. Kodėl taip nutiko? Surašinėjant įvairius duomenis į lenteles, paprastai 
viršutinis duomuo stulpelyje būna pavadinimas, kas šiame stulpelyje bus surašyta (Pvz. „Vardas“, 
„Pavardė“,  „Pajamos“,  „Ūgis“  ir  pan.)  Taigi  skaičiuoklė  įsivaizdavo,  kad  vardas  Nerijus žymi 
stulpelio pavadinimą. Šią klaidą taisome štai taip: virš vardo Nerijus į tuščią langelį turime įrašyti 
žodį  „Vardas“,  pažymėti  visus  turimus  duomenis  ir  surikiuoti  naudojant  rikiavimo  mygtuką. 
Gausime tokį rezultatą:
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Papildykime mūsų turimus duomenis pavardėmis:

Turint daugiau duomenų, rikiavimo principas visiškai pasikeičia. Jeigu dabar pažymėtume 
visus  turimus  duomenis  ir  juos  mėgintume  rikiuoti  tais  pačiais  rikiavimo  mygtukais,  niekas 
nepasikeistų.  O jeigu pažymėtumėme tik  vieną stulpelį,  kuriame yra  surašytos vien pavardės ir 
mėgintumėme rikiuoti pagal abėcėlę, pavardės susirikiuotų, o vardai liktų tose pačiose vietose. Taigi 
būtų sumaišyti vardai su pavardėmis. Tarkime, dabar Adomas yra Žebrauskas, o surikiavus pavardes 
pagal abėcėlę, išeitų, kad Adomas yra Bružaitė. Kaipgi tuomet rikiuoti?

Visų  pirma,  pažymime  visus turimus  duomenis,  tuomet  spaudžiame  meniu  juostoje 
Duomenys → Rikiuoti (angl. Data → Sort). Atsiranda štai toks langas:

Čia prie žodžių Rikiuoti pagal (angl.  Sort by) turime pasirinkti, pagal ką norime surikiuoti 
duomenis. Dešinėje turime pasirinkti, kokiu būdu rikiuosime – Didėjimo tvarka (arba nuo A iki Ž) 
(angl.  Ascending)  bei  Mažėjimo  tvarka (arba  nuo  Ž  iki  A)  (angl.  Descending).  Šitokiu  būdu 
duomenys susirikiuos tvarkingai ir nebus sumaišyti netinkamai.

Patarimas rikiuojant duomenis: visuomet žiūrėkite, kuriuos duomenis derėtų pažymėti, o 
kurių ne.  Pvz.,  jei  prie  duomenų būtų surašyti  eilės  numeriai  (Eil.  Nr.),  jų  pažymėti  rikiuojant 
nereikėtų, nes, priešingu atveju, visi eilės numeriai būtų susimaišę.

22.Diagramų braižymas
Su skaičiuokle galima nubrėžti įvairaus tipo diagramas, pavyzdžiui, stulpelinę, juostinę ar 

skritulinę:
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Stulpelinės ir juostinės diagramos yra sudarytos iš štai šių dalių:

Beveik kiekvieną diagramos dalį galima laisvai pakeisti arba pašalinti.
Kaip pradėti brėžti diagramą?
1 žingsnis. Visų pirma turime turėti duomenis. Duomenys diagramai yra gaunami įvairiai: 

apklausiant kiek nors žmonių, ką nors išmatuojant, pasveriant, suskaičiuojant ir t. t. Taip pat galima 
panaudoti jau turimus duomenis, kuriuos galima rasti vadovėliuose arba internete, pvz.: Pasaulio 
kalnų aukščius, didžiausių Pasaulio ežerų gylius ir t. t.

Turint duomenis, juos reikia surašyti į skaičiuoklę:

Kiekvienas  duomuo  turi  būti  surašytas  į  atskirus  langelius.  Štai  netinkamas duomenų 
surašymo pavyzdys:

2 žingsnis. Turint surašytus visus reikiamus duomenis, juos reikia pažymėti:

Negali  būti  pažymėta  langelių  daugiau  arba  mažiau  nei  yra  duomenų.  Štai  netinkamas 

Medžiagą parengė: Danutė Sebeckytė, 2013
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duomenų pažymėjimo pavyzdys:

3 žingsnis. Spaudžiame ant diagramos mygtuko priemonių juostoje:
4 žingsnis. Atsiradusiame lange išsirenkame norimą diagramos tipą iš sąrašo:

Išsirinkus  norimą  diagramą,  galima  rinktis  du  variantus:  spausti  mygtuką  Baigti  (angl.  
Finish) arba  keliauti  šiame  lange  į  2,  3  ir  4  punktus.  Kol  kas  nuspauskime  mygtuką  Baigti. 
Skaičiuoklėje  turės  iš  karto  atsirasti  diagrama,  tačiau  joje  trūksta  kelių  dalykų,  pavyzdžiui, 
diagramos pavadinimo, X ir Y ašių pavadinimų ir pan.

5 žingsnis. Sutvarkome savo diagramą pagal poreikius. 
Kai diagrama yra pažymėta, pasikeičia viena skaičiuoklės priemonių juosta, esanti viršuje:

Jei tokia juosta neatsiranda, vadinasi, blogai pažymėjote diagramą. Pamėginkite nuspausti 
ant jos du kartus su pele ir stebėkite, ar atsirado ši priemonių juosta. Kol ji neatsiras, tol negalėsime 
redaguoti diagramos.

Pavadinimų įterpimas
Nuspauskite dešiniuoju pelės klavišu ant balto ploto, esančio aplink diagramą:

Atsiradusiame  meniu  pasirinkite  Įterpti  pavadinimus  (angl.  Insert  Titles).  Naujai 
pasirodžiusiame lange galima įvesti pavadinimus diagramai bei X ir Y ašims.

Legenda
Tame pačiame meniu rasite pasirinkimą Šalinti legendą (angl. Delete Legend).  Legenda – 

tai informacija apie diagramą. Joje yra nurodyta, kokia stulpelio spalva ką reiškia. Jeigu legendos 

Medžiagą parengė: Danutė Sebeckytė, 2013
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nereikia, šitaip ją galima pašalinti. Jeigu legendą pašalinote, tačiau vėl ją norite įdėti, nuspauskite 
dešiniuoju pelės klavišu ir pasirinkite meniu Įterpti legendą (angl. Insert Legend).

Legendos ir pavadinimų nustatymai
Pažymėkite  legendą  ir  nuspauskite  ant  jos  du  kartus  su  pele.  Išlindusiame  lange  galite 

parinkti legendos šriftą, spalvą ir kt. parametrus. Lygiai taip pat galite elgtis su diagramos bei ašių 
pavadinimais.

Diagramos stulpelių nustatymai

Nuspauskite ant vieno diagramoje esančio stulpelio. Pastebėsite, kad pasižymi iš karto visi 
trys stulpeliai (šiuo atveju trys stulpeliai nurodo mergaičių skaičių, o kiti trys – berniukų skaičių). 
Du kartus spustelėkite su pele ir išlindusiame lange galite rasti įvairius nustatymus, pvz. stulpelio 
spalvą.  Stulpeliai  gali  būti  užpildomi  ne  tik  viena  spalva,  bet  ir  įvairiais  spalvų  perėjimais, 
paveikslėliais ar raštais.

Nuspaudus dešinįjį pelės klavišą ant pažymėtųjų stulpelių, iškylantis meniu jau bus kitoks, 
negu prieš tai. Čia rasite naujų meniu punktų, skirtų specialiai stulpeliams. Pavyzdžiui, nuspauskite 
Įterpti duomenų etiketes (angl. Insert Data Labels) ir stebėkite, kas atsitiks.

Duomenų etiketės
Kam  reikalingos  duomenų  etiketės?  Parodytame  viršutiniame  pavyzdyje  akivaizdžiai 

matosi, kad pirmasis stulpelis žymi skaičių 12, antrasis – skaičių 14 ir t. t. Tačiau taip būna ne 
visada. Pavyzdžiui:

Medžiagą parengė: Danutė Sebeckytė, 2013
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Čia jau sunkiau nustatyti,  kokį skaičių žymi pirmasis stulpelis  – gal 16,  o gal 17.  Kokį 
skaičių žymi antrasis stulpelis – gal 26, gal 27, o gal 28. Neretai būna atvejų, kai skaičiai būna 
pateikiami procentais arba nenatūraliaisiais skaičiais, pvz.: 45,7%. Kad nereikėtų spėlioti, įterpiame 
duomenų etiketes – t. y. skaičius virš diagramos stulpelių.

Duomenų etiketes, kaip ir diagramos pavadinimą, galima redaguoti – pvz., parinkti norimą 
šriftą,  dydį,  stilių.  Tereikia  jas  pažymėti  ir  dukart  ant  jų  nuspausti  su  pele.  Išlindusiame lange 
sustokime ties lango kortele Duomenų žymės (angl. Data Labels):

Čia  galime  nustatyti,  kaip  duomenų  etiketės  bus  vaizduojamos:  pavyzdžiui,  gali  būti 
nurodyta tiksli skaičiaus reikšmė, kokia buvo įrašyta skaičiuoklės langelyje. Jeigu parinksime, kad 
reikšmė bus atvaizduota procentais, skaičiuoklė automatiškai apskaičiuos, kiek tas skaičius sudaro 
procentų – jų mums savarankiškai skaičiuoti nereikės. Pavyzdžiui, jei diagramoje būtų pavaizduota, 
kad klasėje yra 13 berniukų ir 13 mergaičių, pažymėjus vaizdavimą procentais, matytume 50% ir 
50%.

Dar du svarbūs dalykai šiame lange yra Padėtis ir Pasukti tekstą (angl. Placement ir Rotate  
Text). Prie padėties galime pasirinkti, kur bus duomenų etiketė – gal stulpelio viduje, o gal išorėje ar 
kur kitur. Ką pasirinksime, priklauso nuo diagramos, kokią braižome. Kiekvienas atvejis bus vis 
kitoks.  Pavyzdžiui,  jeigu  parinkome  tamsią  stulpelio  spalvą,  negalime  dėti  duomenų  etiketės  į 
stulpelio vidų, nes jo nesimatys. Parinkti duomenų etikečių padėtį reikėtų taip, kad jos gerai būtų 
matomos.

Štai pavyzdys, kaip galima skirtingai paredaguoti duomenų etiketes:

Medžiagą parengė: Danutė Sebeckytė, 2013
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Ašių formatavimas
Pažymėkime ašį, kurioje yra surašyti skaičiai (šiuo atveju – tai ašis y). Nuspauskime dešinį  

pelės  klavišą ir  pasirinkime  Ašies  formatas  (angl.  Format Axis) (šio  meniu nebuvo matyti,  kol 
nebuvo pažymėta ašis). Jeigu nesiseka pažymėti ašies ir iškviesti šio meniu, viršutinėje priemonių 
juostoje pasirinkite Y ašis ir nuspauskite mygtuką Atrankos formatas (angl. Format Selection):

Ir vienu, ir kitu būdu gausime tokį pat langą:

Lango kortelėje  Mastelis  (angl.  Scale) nužymėkime paukštelius  prie  žodžių  Minimumas 
(angl.  Minimum) ir  Maksimumas (angl.  Maximum).  Minimumas – tai  mažiausias skaičius,  kokį 
rodo Y ašyje,  o maksimumas – didžiausias  skaičius.  Juos  galime keisti,  tačiau tai  daryti  reikia 
protingai ir tik tuomet, jeigu to reikia. Pavyzdžiui, nelogiška būtų padaryti maksimumą 50, kai pats 
didžiausias skaičius mūsų diagramoje yra 25. Tada gautume štai tokį vaizdą:

Diagramos stulpeliai susispaudė, o diagramos plote liko daug tuščios nenaudojamos vietos. 

Medžiagą parengė: Danutė Sebeckytė, 2013
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Taip daryti nepatartina. Diagramos stulpeliai turi išnaudoti beveik visą jai skirtą plotą.
Šioje ašyje dar galima keisti ir skaičiaus intervalą – kiek ir kokių skaičių joje bus surašyta. 

Pvz.: jeigu norime, kad būtų surašyti skaičiai 0, 2, 4, 6 ir t. t., prie žodžių  Pagrindinis intervalas  
(angl. Major Interval) reikia įrašyti skaičių 2, todėl kad ši skaičių seka kinta kas du skaičius. Jei 
norime ašyje matyti skaičius 0, 5, 10, 15 ir t. t., intervalas turi būti 5.

Tame  pačiame  lange  parinkite  lango  kortelę  Linijinė (šis  žodis  tikriausiai  turėtų  būti 
išverstas tiesiog Linija, nes angliškai yra užrašyta Line) – ten galima nustatyti matomąją ašies liniją: 
jos stilių, spalvą, plotį ir kt.

Duomenų sritys
Nuspauskite dešiniuoju pelės klavišu ant balto ploto aplink diagramą ir pasirinkite meniu 

Duomenų sritys (angl. Data Ranges). Atsiras štai toks langas:

Šiame lange kalbėsime tik apie pirmąją kortelę –  Duomenų sritis. Apie kortelę  Duomenų 
sekos (angl. Data Series) nekalbėsime. Pats pirmas dalykas šioje lango kortelėje yra duomenų sritis. 
Čia yra parašytas iš pirmo žvilgsnio keistas dalykas: $Lakštas1.$C$4:$E$7. Pamėginkite į šį užrašą 
pažvelgti,  nekreipdami dėmesio į ženklus $. Tuomet matysime tokį užrašą: Lakštas1.C4:E7. Tai 
reiškia,  kad  duomenys,  iš  kurių  yra  sudaryta  diagrama,  yra  pirmame skaičiuoklės  lakšte,  kurio 
koordinatės yra nuo C4 iki E7. Šiuos duomenis mes jau patys išsirinkome, prieš kurdami diagramą 
(juos buvome pažymėję ranka). Tačiau jeigu dėl kokios nors priežasties prireiktų pakeisti duomenis, 
iš kurių yra brėžiama diagrama, reikėtų nuspausti dešinėje esantį mygtuką su žalia rodykle, ir iš 
naujo žymėti ranka norimus langelius su duomenimis.

Po  Duomenų sritimi yra  kitas  labai  svarbus  dalykas  –  pagal  ką  skaičiuoklė  mums  pieš 
diagramą – pagal stulpelius ar pagal eilutes. Jeigu duomenis surašėme stulpeliais, tuomet reikėtų 
rinktis  Duomenų  seka  stulpeliuose  (angl.  Data  Series  in  Columns). Jeigu  duomenis  surašėme 
eilutėmis, tuomet reikėtų rinktis Duomenų seka eilutėse (angl. Data Series in Rows). Pažiūrėkite ir 
pagalvokite, kurie duomenys čia yra surašyti eilutėse, o kurie – stulpeliuose:

Dar  vienas  svarbus  dalykas:  jeigu  norime  stulpelinės  diagramos,  rašykime  duomenis 
stulpeliuose, o jeigu juostinės – eilutėse. Tačiau, įsidėmėkite – viską galime daryti ir atvirkščiai. 
O  koks  gi  tuomet  skirtumas,  ką  ir  kaip  rašyti?  Pamėginkite  paanalizuoti,  kaip  skiriasi  ta  pati 
stulpelinė diagrama, jeigu pakeisime jos duomenų seką iš stulpelių į eilutes:

Medžiagą parengė: Danutė Sebeckytė, 2013
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• Pirmas dalykas, kuris iškart krenta į akis – tai stulpeliai. Pirmojoje diagramoje buvo šeši 
stulpeliai, sugrupuoti po du, o antrojoje – sugrupuoti po tris. Vadinasi, skaičiuoklė visiškai 
perpiešia diagramą iš naujo. Duomenys nėra klaidingi nei pirmoje diagramoje, nei antroje, 
tačiau jie yra kitaip interpretuojami ir perpiešiami. 

• Antras dalykas, į kurį reikėtų atkreipti dėmesį – diagramai suteikti ašies vardai nebetinka. 
Na,  tiksliau,  vienas  pavadinimas  tinka,  o  kitas  –  nebe.  Šiuo  atveju  pavadinimus  tektų 
pakeisti.

• Trečias dalykas – atkreipkite dėmesį į tai, ką rodo legenda abiejose diagramose. 
• Ketvirtas  dalykas  – kadangi  atsirado nauji  stulpeliai,  kurių  prieš  tai  nebuvo,  jiems  nėra 

įterptos duomenų etiketės (buvo tik žalias stulpelis ir raudonas, o staiga atsirado naujas – 
geltonas), vadinasi, jas reikėtų iš naujo įterpti.
Tokios duomenų srities transformacijos  ne visuomet pavyksta sėkmingai. Tai priklauso 

nuo to, kiek ir kokių duomenų mes turime. Kartais gali nutikti taip, kad legenda rodys visai ne tai,  
ko  mes  tikimės,  o  kartais  gali  atsirasti  stulpelis,  kuris  visiškai  nieko  neparodo  ir  yra  niekam 
nereikalingas, tačiau jo pašalinti neįmanoma. Dar gali būti, kad ašių pavadinimai neatitiks prasmės 
arba  prie  kiekvieno  stulpelio  bus  užrašytas  neaiškus  skaičius  (pvz.  Vietoj  „Berniukai“  ir 
„Mergaitės“ bus užrašyta „1“ ir „2“, ir šių skaičių nebus įmanoma nei pakeisti, nei pašalinti). Todėl 
geriau  patartina  daryti  viską  pagal  taisykles  –  jeigu  rašome  duomenis  stulpeliais,  pasirinkime 
Duomenų seka stulpeliuose, ir brėžkime stulpelinę diagramą. Jeigu surašome duomenis eilutėmis, 
pasirinkime Duomenų seka eilutėse ir brėžkime juostinę diagramą. Tam, kad suprasti, kada ir kaip 
diagramų  brėžimas  pavyksta  sėkmingai,  viską  darant  atvirkščiai,  reikia  mėginti  brėžti  daug 
įvairiausių diagramų. Kuo daugiau diagramų brėšite, tuo lengviau suprasite, kaip surašyti duomenis 
ir kokią duomenų seką parinkti.

Skritulinė diagrama
O kokią duomenų seką parinkti, brėžiant skritulinę diagramą? Atsakymas paprastas: rinkitės 

tokią, su kuria diagrama rodo teisingus duomenis.
Vienas patarimas, brėžiant skritulines diagramas – niekada nebrėžkite skritulinės diagramos 

iš daug duomenų. Labai sunku suprasti, ką vaizduoja tokia diagrama:

Medžiagą parengė: Danutė Sebeckytė, 2013
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Yra aišku tik tiek, kad raudona spalva žymimos mergaitės, o mėlyna – berniukai. O iš kurių 
klasių šie duomenys – neaišku.

Skritulinės diagramos yra dažniausia naudojamos, kai neturime daug duomenų arba tiesiog 
darant apklausas, kai atsakymų į klausimus variantų yra keletas (nuo 2 iki maždaug 10). Pavyzdžiui, 
galime nubrėžti diagramą iš vienos klasės sudėties:

Šitoje diagramoje viskas turėtų būti  aišku – klasė:  8a.  Berniukų skaičius:  14,  mergaičių 
skaičius: 12. Skritulinė diagrama yra daug paprastesnė už stulpelinę ar juostinę – čia nėra X ir Y 
ašių, nereikia joms nustatyti pavadinimų ar didžiausios ir mažiausios ašies reikšmės.

Sėkmės braižant diagramas!

Medžiagą parengė: Danutė Sebeckytė, 2013

80 Pav. Blogai nubraižyta skritulinė diagrama

12

14

13
15

11
14

Mokinių skaičius aštuntose klasėse

Skritulinė diagrama

Mergaitės

Berniukai

81 Pav. Skritulinė diagrama

12

14

Mokinių skaičius 8a klasėje

Skritulinė diagrama

Mergaitės

Berniukai


